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The hemodynamic forces experienced by the heart influence cardiac development, especially trabeculation, which forms a network of branching
outgrowths from the myocardium. Genetic program defects in the Notch signaling cascade are involved in ventricular defects such as Left
Ventricular Non-Compaction Cardiomyopathy or Hypoplastic Left Heart Syndrome. Using this protocol, it can be determined that shear stress
driven trabeculation and Notch signaling are related to one another. Using Light-sheet Fluorescence Microscopy, visualization of the developing
zebrafish heart was possible. In this manuscript, it was assessed whether hemodynamic forces modulate the initiation of trabeculation via Notch
signaling and thus, influence contractile function occurs. For qualitative and quantitative shear stress analysis, 4-D (3-D+time) images were
acquired during zebrafish cardiac morphogenesis, and integrated light-sheet fluorescence microscopy with 4-D synchronization captured the
ventricular motion. Blood viscosity was reduced via gata1a-morpholino oligonucleotides (MO) micro-injection to decrease shear stress, thereby,
down-regulating Notch signaling and attenuating trabeculation. Co-injection of Nrg7 mRNA with gata1a MO rescued Notch-related genes to
restore trabeculation. To confirm shear stress driven Notch signaling influences trabeculation, cardiomyocyte contraction was further arrested
via tnnt2a-MO to reduce hemodynamic forces, thereby, down-regulating Notch target genes to develop a non-trabeculated myocardium. Finally,
corroboration of the expression patterns of shear stress-responsive Notch genes was conducted by subjecting endothelial cells to pulsatile flow.
Thus, the 4-D light-sheet microscopy uncovered hemodynamic forces underlying Notch signaling and trabeculation with clinical relevance to non-
compaction cardiomyopathy.

Video Link

The video component of this article can be found at https://www.jove.com/video/57763/

Introduction

Biomechanical forces, such as hemodynamic shear stress, are intimately involved in cardiac morphogenesis. In response to hemodynamic
shear forces, myocardial ridges and grooves develop in a wave-like trabecular network in alignment with the direction of the shear stress
across the atrioventricular (AV) valve . Cardiac trabeculation is necessary to increase contractile function and myocardial mass2. Mutations in
Notch signaling pathways result in congenital heart defects in humans and other vertebrates®. For example, gata1a4 and tnnt2a® morpholino
oligonucleotides (MO) have been shown to reduce erythropoiesis, while erythropoietin mRNA (EPO)6 and Isoproterenol (ISO)7 increase red
blood cells and heart rate respectively, and therefore wall shear stress (WSS). Furthermore, ErbB2 signaling, downstream of Notch, promotes
cardiomyocyte proliferation and differentiation to generate contractile force, which in turn activates Notch signalings’g. It is suggested that
shear stress governs Notch signaling driven trabeculation for ventricular development. Currently, there are many studies that attempt to further
understand the genetic programming events leading to congenital heart defects (CHD)1°'“’12, but very little are investigating how mechanical
forces influence the forming heart.

In order to investigate the mechanical forces acting on the endocardium, close observation during the developmental period needs to

be implemented. However, it is challenging to obtain good quality images of in vivo beating samples due to the inherence of traditional
microscopy13. In order to observe the development over time within a sample, physical sectioning and staining, therefore, need to oceur'®
Although confocal microscopy is widely used to image the 3-D structure of samples ™, these imaging systems' acquisition is still limited by slow
scanning speeds.

14,15
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Light-sheet fluorescence microscopy (LSFM) is a unique imaging technique that allows the visualization of in vivo dynamic events with long
working distance™. This technique uses a light-sheet fluorescent microscopy to optical?f section a sample”. Due to illumination of only a thin
sheet of light on the sample, there is a reduction in photo-bleaching and photo toxicity1 "8 The large field of view and long working distance
allows for large samples to stay intact as they are imaged13'14’17. The low magnification allows for a larger area to be imaged, while the long
working distance allows for thicker samples to be imaged without compromising the signal-to-noise ratio. Many groups have used LSFM to

image entire embryos”, brains '8, muscles and hearts'® among other tissues, showing the diverse types of samples that can be imaged.

Although previous research demonstrated reduced hemodynamic shear force by occluding the inflow or outflow tracks of the zebrafish heart,

the information is solely qualitative. It results in an abnormal third chamber, diminished cardiac looping, and impaired valve formation®. The

4-D LSFM images give a new perspective into the way the hemodynamic shear forces affect the development of the cardiac tissue. These
mechanical forces may activate force-sensitive signaling molecules and induce the formation of the trabecular ridges. Because of the added
time aspect of 4-D imaging, one is able to track changes in development in real time, which could lead to new revelations that had gone
unnoticed previously. The zebrafish is an ideal model for imaging because scientists can observe an entire vertebrate animal versus only cell-cell
interactions. Oxygen can also diffuse through the entire embryo, which allows development to occur without depending on the vascular system,
unlike in mammalian development. Even though the zebrafish heart lacks the pulmonary organs, which require a four-chambered heart, there is
a large number of cardiac genes that are conserved between zebrafish and humans?".

In this manuscript, we describe how to use light-sheet fluorescence microscopy to image the developing trabeculae in zebrafish hearts under
various circumstances. First, injection of gata1a4 or tnnt2a® MOs were used to lower the blood viscosity, and therefore WSS. The morphology of
the heart was then recorded. In a separate group of fish, we increased the WSS by administering EPO mRNA?® or isoproterenol7 and observed
the results. We also conducted a cell study with different pulsatile or oscillatory flow rates. After imaging each group, we found that WSS sensed

by the endocardium via Notch signaling initiates trabeculation.

The following methods were performed in compliance with UTA and UCLA IACUC protocols. These experimental groups were used with
transgenic Tg(cmlc2:9fp), the wea (weak atrium) or clo (cloche) mutants: (a) wild-type (WT) control, (b) gataia MO, and (c) tnnt2a MO injections

(Table 1).
Model Name Modified Genes Phenotype Reference
Control Wild type None N/A
Tg(cmic2:gfp) Cardiac myosin light chain | Green flourescence 34
specifically expressed in
the myocardium
Decreased Wall Shear Weak atrium (wea) mutant | Atrium-specific myosin Atrium cannot contract, 37
Stress heacy chain compact ventricle, thick
myocardial wall, narrow
lumen, dialated atrium,
Cloche (clo) mutant N/A Complete removal of 41
endocardium, unaturally
large atrium with small
ventricle, nonexistent
cardiac cushins
gatala MO gatala Anemia from lack of red 4
blood cells
tnnt2a MO tnnt2a 39
Increased Wall Shear EPO mRNA None Severe polycythemia, 6
Stress increase in number of
circulating blood cells,
increased viscosity
Isoprotenerol None Increased cardiac rate 7

Table 1: Zebrafish descriptions. Definitions and descriptions of Zebrafish used in experiments.

1. Study Setup

1. Prepare Nrg1 and EPO mRNA for trabeculation rescue.
1. Obtain Human Nrg7 cDNA and amplify from a donor plasmid.
Note: The Human Nrg7 cDNA was gifted from William Talbot from Stanford University.
1. Take out necessary reagents and materials, namely PCR mastermix (stored in -20 °C), primers (See Table 2) (stored in -20
°C), a PCR plate (stored at room temperature), and a 20 uL pipette (stored at room temperature). See Table of Materials for
example products.

hNrgl-Clone

Forward

TCTTTTTGCAGGATCCACCATGGAGATTTATTCCCCAGACATGTCTG

Backward

GAGAGGCCTTGAATTCCTATTCAGGCAGAGACAGAAAGGGAGTG

Copyright © 2018 Journal of Visualized Experiments

August 2018 | 138 | e57763 | Page 2 of 10


https://www.jove.com
https://www.jove.com
https://www.jove.com

L]
lee Journal of Visualized Experiments www.jove.com

Table 2: Primers for human Nrg1 cloning.

2. Prepare the mastermix for each primer set in triplicate using the 20 L pipette. For 1 set of triplicates, use 37.5 pL of the
mastermix, 3 yL of DNA-free water, 4.5 pL of primer. For more triplicates, simply multiply by the number of samples.

3. Dilute the working solution Human Nrg7 cDNA (20 ng/ug concentration) in the primer strip with DNA-free water so that there is
10 L total per well per sample.
Note: Ensure that each solution under step 1.1.1 is evenly distributed. Do this by mixing each solution by pipetting up and down.
To prevent cross-contamination, use one pipette tip for only one sample.

4. Aliquot the Nrg1 cDNA with the 10 uL multi-channel pipette to desired wells in the PCR plate.

5. Add 14.5 pL of the mastermix to the cDNA in the wells. Apply a sticky cover to the PCR plate to seal the wells, and place into the
PCR machine.

6. Start the PCR machine and ensure that the cycle reaches appropriate temperatures according to the enzymes and primers used.

2. Clone the Nrg? cDNA into the plasmid pCS2" at the BamHI and EcoRl sites using excess enzymes BamHI and EcoRI to ensure cDNA
is ligated in all plasmids.

1. Mix the Nrg7 cDNA with the donor plasmid pCS2", commercially available master mix solution and primers (Table 2).
Note: The total reaction volume should be 50 pL with 25 pL of master mix, 3 pL of primers and 1 pL of 20 ng/uL donor plasmid
with Nrg1 cDNA.

2. Place the mix from step 1.1.2.1 in the PCR machine and set the parameters to meet the following specifications: 98 °C for 10 s,
55°Cfor50r15s, and 72 °C for 5 s/kb.

3. Purify the PCR product using a purification kit following the manufacturer's instructions. Elute the product into 50 pL of elution
buffer.

4. Digest the purified PCR product and 5 g of pCS2* with BamHI and EcoRI separately at 37 °C for 2 h in a 200 uL reaction
volume. Purify the resulting digestion with a commercial kit and elute in 20 yL and 100 pL of Tris-HCI (pH 8.5), respectively.

5. Ligate 4 pL of Nrg7 cDNA and 2 pL of the digested pCS2* plasmid in a 25 pL reaction with 1 UL of a ligase catalyst at 16 °C
overnight.
Note: The procedure can be stopped here for overnight incubation.

6. Use 2 L of the ligation solution from step 1.1.2.5 and transform into 50 L of E. coli bacteria cells suitable for cloning (see Table
of Materials).

3. Confirm that the transformation took place by screening the Nrg7 cDNA clones using PCR. Choose clones at random and add to a
solution of specific primers, polymerase, and deoxyribonucleotide triphosphates (ANTPs).
Note: The controls were the vector (pCS2") with and without the insert (human cDNA). Do not pick too big of a colony because
excessive bacteria can inhibit PCR.
1. Pick 8 colonies from the transformation and screen pCS2°*-Nrg1 clones using the PCR primers from Table 2.
2. Culture one clone with Nrg7 cDNA to isolate the pCS2*-Nrg1 plasmid DNA. Inoculate with 100 pL of E. coli bacteria with pCS2*-
Nrg1 plasmid into 100 mL of LB media, and culture by shaking (160 - 225 RPM) at 37 °C.

4. Transfect purified pCS2*-Nrg1 plasmid into HEK-293 cells in a 6-well plate using a commercial transfection reagent following the
manufacturer's instructions.
5. 24 h after transfection, Iglse the cells using a lysis buffer and run through an SDS-PAGE gel, transfer to a gel membrane, and then stain
with anti-Nrg1 antibody 2, Verify Nrg1 protein expression using a Western Blot.
Note: The control is an empty pCS2" plasmid. Can be paused here if gel membrane transfer occurs overnight.
6. Synthesize Nrg7 mRNA using a commercial product similar to that in the Table of Materials and follow the manufacturer's instructions.
1. Take 5 pL of the pCS2*-Nrg1 DNA from the bacteria isolated culture, and digest with Notl in a 200 pL reaction for 2 h at 37 °C to
linearize the plasmid.
2. Purify the linearized plasmid with a commercial kit and elute in 20 pL of Tris-HCI (pH 8.5).
3. Conduct in vitro transcription with a commercial RNA isolation kit in a 20 pL reaction using 5 pL of the linearized plasmid
following the manufacturer's instructions.
4. Add the in vitro transcribed Nrg1 to 350 L of RNA lysis buffer and then purify with an RNA isolation kit. Elute the RNA into 60 pL
of Tris-HCI (pH 8.5).
5. Measure the RNA concentration and store at -80 °C for future use.

7. Follow steps 1.1.6.1 - 1.1.6.5 above for the EPO cDNA and mRNA preparation but clone the cDNA into the pCS2+ plasmid at EcoRI
and Xhol sites instead.

2. Inject Morpholino into zebrafish

1. Design23 the MO injections using an online tool (Table of Materials) against the ATG sequence of gata1a4 (5'-
CTGCAAGTGTAGTATTGAAGATGTC-3') and tnnt2a® (5'-CATGTTTGCTCTGATCTGACACGCA-3').

2. Add gatata and tnnt2a MO separately to the nuclease-free water to make the final concentrations of 8 ng/nL and 4 ng/nL, respectively.
Repeat with EPO mRNA with a final concentration of 20 pg/nL. Ensure that the final volume is 1 mL.

3. Inject 1 nL of the 8 ng/nL of gatata MO and 1 nL of the 4 ng/nL of tnnt2a MO into separate zebrafish embryos at the 1 to the 4-cell
stage to reduce ventricular wall shear stress (WSS)24. To increase WSS, inject 1 nL of 20 pg/nL of EPO mRNA? into the zebrafish
embryos at the 1- to 4- cell stage.

3. Chemically treat zebrafish to inhibit trabeculation
1. Using a 20 mL pipette, dilute the 10 mg/mL AG1478 in 1% DMSO in E3 medium to a final concentration of 5 yM at 30 hpf into a 15 mL
tube. As a control, treat each fish with 1% DMSO only.
2. Add N-[N-(3,5-Difluorophenactyl)-L-Alanyl]-S-Phenylglycine t-butyl ester (DAPT) in 1% DMSO (100 pM) to E3 medium in a 15 mL tube
to inhibit Notch signaling at 40 hpf in a similar fashion. As a control, treat with only 1% DMSO.
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2. Imaging Techniques

1. 4-D cardiac LSFM Imaging with synchronization algorithm
1. Take 2-D images of the entire fish embryo over multiple cardiac beating cycles using the steps below (Figure 1) . Ensure that the light-
sheet thickness is approximately 5 pm. Take 500 x-y frames with an exposure time of 10 ms. Set the z-scanning to 1 pm for lossless
digital sampling according to the Nyquist sampling principlezs.
1. Create a 1% (w/v) agarose gel by adding 1 g of agarose to 100 mL and heating it until all agarose is dissolved. Load a small
plastic tube with the embryo and agarose using a 20 uL pipette and secure it on the stage.
2. Open the image viewing software and click Live to see the live view of the sample. Adjust the objective using the knob so that
the sample is in focus. Similarly, move the stage so that the live view of the sample shows the top of the embryo.
3. Take images 500 times for 5 s at 10X magnification using the microscope's software®®.
4. Move the stage using the motor to a new layer (1 um in the z-axis) and repeat the imaging procedure.
5. Repeat above 2 steps until entire heart is fully imaged.

2. Ensure data integrity by disregarding the first and last cardiac cycle images. Find the period of the cardiac cycle by matching images
that were taken at the same time point in the cardiac cycle, but in different periods. Use the following equation that was developed to
find the period:

e 2 e -7/ )"
D(Zk'TJj = EmeZ: _:"ﬁll |'{m [xm’zk ri':j)] - Im [‘X,Zk, rt'_;l):” + | d it /Tﬂﬂi (1)

where D is the cost function used for fitting a period hypothesis, I, the captured image, 7' the time the image was captured, z, the z-
direction index of the image, x,, is the vector of the pixel index, and T"is the periodic hypothesis.
3. Use the following equation to find the relative shift between two pictures in similar stages:

(8) = [le J3 (2, 230, 8) — I, (2, 2, — ) |2 ditdx (2)
where Qi denotes a cost function for the relative shift, R is the possible spatial neighborhood, L is the total time of capturing the
image, x is the pixel index, z, and z, are the first and second z-direction slices, t is time, and s is the relative shift hypothesis.
4. Convert the relative shift to absolute shift with respect to the first image and solve the linear equation using the pseudo-inverse
approach, to find the absolute relation to align the next section of images as previously described?’.
5. The final 4-D images were processed using image processing software (Table of Materials).
1. Stacking 2-D images into 3-D
Open a commercial image processing software.
Click Open Data.
Select all the images to be stacked into 3-D > Click Load.
Add in the voxel size of 0.65 x 0.65 x 1 > Click OK.
Click the Multi-Planar View box to visualize the 3-D image.
Right-click the blue slice_1.tiff box > Select Display > Select Volren.
Click Edit > Select Options > Select Edit Colormap.
Adjust the color using the boxes outlined in red > Click OK.

PN WD~

2. Converting 3-D to 4-D

. Click "File > Open Time Series Data.

Select the 3-D tiffs that were just made > Click Load.

Enter the same voxel size as before.

Right click the blue slice_1.tiff box > Select "Display" > Select Volren.

Click Edit > Select Options > Select Edit Colormap. Adjust the color using the boxes > Click OK.

Right click Time Series Control > Click Movie maker > Press the Play button in order to watch the movie.
Add a file name, frame size, frame rate, quality equal to 1, type Monoscopic > Click Apply

Export the video. Open the video in an appropriate software.

PNOOA LN

3. qRT-PCR analysis

1. Zebrafish heart RNA Isolation to quantify Notch ligands, receptors, and target genes' exgressions

1. Sacrifice the zebrafish by subjecting them to an overdose of tricaine methylatezg'2 . Using a previously described protocol3°, the
zebrafish hearts were excised and prepared for RNA isolation.

2. Isolate the total RNA, and synthesize the cDNA using the cDNA synthesis kit following the manufacturer's instructions.

3. Design the PCR primers for the Notch ligands Jag1, Jag2, Dll4, receptor Notch1b, and signaling related genes Nrg1 and ErbB2. See
Table 3 for the primers we used.

4. Add the primers from step 3.1.3, the isolated mRNA from step 3.1.2, and a commercial mastermix to the PCR plate. Run the gRT-PCR
at the appropriate temperatures and times according to the enzymes used. Normalize the results to zebrafish a-actin.
Note: This will calculate the expression levels for each of the ligands, receptors, and genes.

4. In vitro Human Aortic Endothelial Cell (HAEC) Experiments

1. Dynamic Shear Stress Model
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1. Culture HAEC cells with HAEC culture media. Once fully confluent, expose the cells to laminar flow and pulsatile flow of 23 x 10° N at
the rate of 1 Hz for 24 h.

1. Warm up EC media/DMEM 10% FBS in a water bath for 20 min.

2. Retrieve HAEC cells from liquid nitrogen tank and place the vial into the water bath until melted.

3. Using a 1,000 pL pipette, remove the thawed cells and put them in a 15 mL tube with 3-5 mL of media. Centrifuge the cell
solution at 53 x g for 3 min.

4. Aspirate the solution off and add enough media for a total volume of 10 mL. Add the cell solution to a sterile T75 flask, cap the
flask, and distribute the cells evenly on the bottom of the plate.

5. Mark the flask with initials, date, cell type, and passage number. Incubate the flask at 37 °C, 5% CO,, until cells are 80%
confluent. Remember to change the media every 2-3 days.

6. Using a commercial pump, attach the tubing to the flask, and set the parameters mentioned above in step 4.1 313233

2. Add GI254023X to 50 mL of HAEC medium at a final concentration of 5 uM for 30 min.

3. With the pre-mixed GI254023X, an ADAM10 inhibitor which suppresses Notch signaling, conduct the same laminar flow or pulsatile
flow experiments as in 4.1.1.

4. Quantify Notch ligands (Jag1, Jag2, and DIll4) and Notch target genes (hairy and enhancer of split [Hes]) using qRT-PCR for four
groups of HAEC samples (laminar flow, laminar flow + G1254023X, pulsatile flow, pulsatile flow + GI254023X) described previouslysz.

5. Rescue and over-expression of Notch signaling

1. Inject 1 nL of the prepared Nrg7 mRNA at a concentration of 5 pg/nL (from step 1.1.6) at the 1- to 4-cell stage with the gata7a MO in order to
overexpress Notch target gene524.

2. Inject 1 nL of the Nrg?7 mRNA into wea mutant in a similar way24.

3. Double the concentration of Nrg1 mRNA QO pg/nL) and inject24 1 nL into zebrafish to observe the ventricular morphology.

4. Inject 1 nL of the 20 pg/nL of EPO mRNA” into the zebrafish embryos at the 1- to 4- cell stage to augment hematopoiesis to increase
ventricular WSS as previously shown®*,

5. Inject 1 nL of the 50 uM Isoproterenol7, which increases the rate of contractility, to the E3 medium for 24 h while zebrafish are cultured as
previously shown?*,

6. Perform 4-D LSFM imaging for each group. Follow the instructions in steps 2.1.1-2.1.5.2.8.

6. Quantification of Fractional Shortening and volume change over time

1. Perform 4-D LSFM imaging for each group at 50, 75, and 100 hpf. Follow instructions in steps 2.1.1-2.1.5.2.8. Divide each image so each has
600 nodes for replication of the cardiac wall motion.
2. Measure the change in diameter of the ventricle during diastole and systole using the following formula:

. . End diastolic diameter —End systolic diameter
Fractional Shortening = ( - —— ) % 100 (3)
End diastolic diameter

Load 3-D ventricular images at every 0.1 s with visualization software and measure the volume.
3. Plot the volume change over time for each experimental group at 75 hpf and 100 hpf.

Representative Results

LSFM was used in this manuscript in order to acquire high-resolution 2-D and 3-D pictures. As seen in Figure 1A and 1B, the illumination lens
directs the light sheet at the sample. Because of the thinness of the light sheet, only a single plane is illuminated. The detection lens is positioned
perpendicular to the illumination lens and is focused on the illuminated plane (Figure 1B). The light sheet from the illumination lens then scans
the sample from left to right (Figure 1C). The scanning allows less photo-bleaching, photo-toxicity, and has a lower signal-to-noise ratio.

LSFM was applied to Tg(cmlc2a:gfp) embryos to visualize the entire cardiac structure® by rapid scanning (> 30 s) with a voxel resolution of

0.65 x 0.65 x 1 ym. Due to a single plane illumination, background noise was significantly reduced (Figure 1). Trabecular ridges protruded into
the ventricular lumen at 75 hpf, and a trabecular network clearly was shown at 100 hpf (Figure 2A, B). Gata’a MO micro-injection reduced
hematopoiesis and viscosity by 90%*%. This decreased viscosity attenuated hemodynamic shear stress, resulting in a delayed initiation and
density of trabecular network at 75 hpf and 100 hpf when compared to control group (Figure 2C, D). Furthermore, Notch ligands (D//4, Jag1, and
Jag?2), receptor (Notch1b), and downstream signaling components (Nrg7 and ErbB2) were down-regulated in response to gata’a MO injection

(p < 0.05, n=5) (Figure 2K)2’8‘36. Co-injection of gatata MO with 5 uM of Nrg7 mRNA up-regulated Notch signaling-related gene expression and
rescued trabecular formation at 75 hpf and 100 hpf (Figure 2E, F, K). Thus, gata’a MO reduced hemodynamic forces leading to down-regulation
of Notch signaling, whereas Nrg7 mRNA rescue up-regulated Notch-related genes and re-initiated trabeculation.

In order to further prove our hypothesis that changing hemodynamic forces and thus trabeculation via Notch signaling, we introduced the wea
mutant that develops a non-contractile atrium®”. In the absence of ventricular inflow and hemodynamic forces during atrial systole, wea mutants
express lower cardiac mRNA levels of Notch signaling component genes and target genes compared to controls, and harbor non-trabeculated,
small and weakly contracting ventricles (Figure 2G, L). However, Nrg7 mRNA micro-injection into the wea mutants up-regulated the Notch
signaling pathway, accompanied by the partial rescue of trabecular ridges, leading to a more pronounced contractile ventricle despite a non-
contractile atrium (Figure 2H, L)2. In this context, the wea mutants corroborated the relation between the non-contractile atrium and a non-
trabeculated ventricle, underscoring the hemodynamic modulation of trabeculation via Notch signaling.
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Tnnt2a MO was delivered to stop cardiac contraction by inhibiting cardiac troponin %% The thnt2a MO-injected fish were completely devoid

of circulation and ventricular WSS due to significant down-regulated Notch signaling, leading to a smooth ventricular surface and thin wall when
compared to control group (Figure 21, M). To investigate whether WSS on the endocardium was a requirement for trabeculation, we also have
cloche (clo) mutants for which endocardium and the endothelial lining of the heart do not develop40'41. The clo mutant failed to develop cardiac
trabeculae and showed smaller sized ventricle and incomplete cardiac looping (Figure 2J). Thus, the endocardial lining is necessary to sense
hemodynamic shear stress to activate Notch signaling (Figure 2M). However, when the hemodynamic shear stress was increased by increasing
hematopoiesis or treatment of isoproterenol to increase contractility, the expression levels of Notch-related genes did not increase, and the
trabecular network morphology did not change (Figure 3).

To further demonstrate the relationship between shear stress and Notch signaling, HAECs were used for in vitro tests. A pulsatile flow was
exerted on confluent cells to simulate the hemodynamic shear stress observed by endothelial cells. It is shown that compared to static culture,
pulsatile culture increases expression of Notch-related genes (Figure 4). Furthermore, treatment with the ADAM10 inhibitor significantly reduced
Notch signaling (Figure 4).

Next, we calculated ventricular fractional shortening, and ventricular cavity change in volume over time for the wild-type, gatata MO, AG1478,
and those rescued by Nrg1 injection groups at 50 hpf, 75 hpf, and 100 hpf (Figure 5A-C). Treatment with ErbB signaling inhibitor, AG1478,
significantly delayed and reduced fractional shortening during ventricular diastole at 100 hpf (Figure 5A). Both gata’a MO and AG1478
treatment reduced ventricular chamber size during contraction, as assessed by the changes in 4-D LSFM (Figure 5E, F). Both groups developed
an increased end-systolic and -diastolic volume when compared to the wild-type. Co-injection of Nrg7 mRNA with gata1a MO restored both
fractional shortening, and Ejection Fraction toward those of the wild type.

Scanning Laser
light-sheet

Moving
Embryo

Figure 1: Fluorescent light sheet overview. (A) Representative LSFM system where the sample is placed in the intersection of the light sheet
from the illumination lens (IL) and the detection path of the detection lens (DL). (B) The cylindrical lens behind the IL creates the micron-sized
light sheet (purple) within the sample, which excites a thin sheet of the sample. The detection lens records the emitted fluorescent signal. (C) A
schematic of the thin laser sheet (purple) optically sectioning the zebrafish embryo which moves right to left. This figure has been modified from
Lee et al'’. Please click here to view a larger version of this figure.

Ralstren Goe Lxpression

Relative Gene Expression

Figure 2: Ventricular morphologies of genetically manipulated Tg(cmlc:gfp) zebrafish with Notch Ligand, receptor, and target gene
expression. (A) The trabecular network is shown at 75 hpf of control zebrafish. (B) The trabecular network at 100 hpf of control zebrafish. (C)
Injection of gatata MO at the 1- to 4-cell stage showed little to no trabeculation at 75 hpf. (D) Injection of gata’a MO into zebrafish had delayed
trabecular network formation. (E) Co-injection of gataa MO and human Nrg? mRNA partially restored trabeculation at 75 hpf. (F) Co-injection
of gata1a MO and human Nrg7 mRNA almost completely restored the trabecular network at 100 hpf. (G) wea mutant at 100 hpf shows no
trabeculation and a smooth ventricular wall. (H) Injection of human Nrg7 into wea mutant zebrafish partially restored trabeculation at 100 hpf.
(1) Injection of tnnt2a MO showed no trabeculation at 75 hpf (not shown) and 100 hpf. (J)clo mutant showed no trabeculation at 100 hpf. (K)
Injection of the gata1a MO significantly reduced mRNA expression of Notch1, Nrg1, and Jag2 (t-test, *P < 0.05, n=5 vs. control). Co-injection of
gatala MO and human Nrg7 mRNA significantly increased the expression of Notch1b, Nrg1, ErbB, and Jag1 compared to control. (L) The wea
mutant had the significantly lower expression of Notch-related genes (t-test, *P < 0.05, n=5 vs. control). Injection of human Nrg1 increased the
expression of Notch-related genes; Jag? and Jag2 were significantly higher than control. (M) The tnnt2a MO injection and clo mutant showed
a significantly lower expression of Notch-related genes (t-test, *P < 0.05, n=5 vs. control). Scale bars: 50 ym. Data are shown as the mean
standard deviation. This figure has been modified from Lee et al'’. Please click here to view a larger version of this figure.
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Figure 3: Increasing WSS in manipulated Tg(cmlic:gfp) zebrafish with Notch ligand, receptor and target gene expression in vivo.
Increasing the WSS via over-expression of hematopoiesis with the injection of EPO(A) or addition of ISO (B) via increasing heart rate did not
increase trabeculation and had a trabecular network similar to that of the control. (C) The injection of EPO mRNA or Isoproterenol did not change
the expression of Notch ligand, receptor or target genes (t-test, *P < 0.05, n=5 vs. control). This figure has been modified from Lee et al'”. Please
click here to view a larger version of this figure.

4 - *
3.5 4

[

[=]

‘> 3 4

v

225

& * *

g 2

&

o 1.5 4

2

& 1

[T}

e

il

Hesl| DIl4 |Jagl|Jag2|Hesl|DIl4 |Jagl|Jag2|Hes1| DIl4 |Jagl|Jag2 HesI| DII4‘Jag1[1ag2

Static 24hr PSS GI254023X 24hr PSS
Treatment +GI1254023X

Figure 4 Endothelial cells subject to oscillatory or pulsatile shear stress in vitro. HAECs subject to the pulsatile shear stress of Tayerage =

30 x 10° N/s at 1 Hz had upregulated Notch-related gene expressions and downregulated of Notch-related gene expressions when the ADAM10
inhibitor was applied (t-test, *P < 0.05, n=5 vs. control). This figure has been modified from Lee et al'’. Please click here to view a larger version
of this figure.
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Figure 5: Effect of trabeculation of fractional shortening and ejection fraction. (A-C) Addition of AG1478 and gata1a MO significantly
decreased the fractional shortening at 100 hpf, but co-injection of human Nrg7 and gata1a MO improved it. (D) gatata injection and AG1478
significantly decreased the fractional shortening at 100 hpf (t-test, *P < 0.05, n=5 vs. control). Co-injection of gatafa and Nrg7 mRNA improved
the fractional shortening. (E-F) Integrating the 4-D synchronization algorithm with LSFM showed that AG1478 and gata1a MO had increased end
systolic and diastolic volumes at 75 hpf (E) and 100 hpf (F). Data are shown as the mean standard deviation. This figure has been modified from
Lee et al'’. Please click here to view a larger version of this figure.

Zebrafish Jag1 Forward CCGCGTATGTTTGAAGGAGTATCAGTCG
Backward CAGCACGATCCGGGTTTTGTCG
Zebrafish Jag2 Forward AGCCCTAGCAAAACGAGCGACG
Backward GCGTGAATGTGCCGTTCGATCAA
Zebrafish DIl4 Forward CAAAGTGGGAAGCAGACAGAGCTAAGG
Backward CGGTCATCCCTGGGTGTGCATT
Zebrafish BMP10 Forward GCATCAAGGGGCCACTCGTGTAGA
Backward TCGTCTCACTCCACTAGGTCCCATACTG
Zebrafish ErBb2 Forward GATCAGGACTGCCAAACATTGACGTCT
Backward AGCAGCACACTGAACATGGCAGCA
Zebrafish Nrg-1 Forward GTGTGTTTGTCCCTGTGGACGCGT
Backward CCTCCTGGAGCTTCCCCTCAAACA
Zebrafish Notch1b Forward CAGAGAGTGGAGGCACAGTGCAATCC
Backward GCCGTCCCATTCACACTCTGCATT

Table 3: Primers used for Zebrafish screening.

In this protocol, we have shown that 4-D imaging can be used to track the development of a trabecular network in response to changes in
biomechanical forces. In particular, the shear stress experienced by endothelial cells initiates the Notch signaling cascade, which in turn
promotes trabeculation. In this manuscript, we have shown that (1) gata’a MO injection decreased hematopoiesis and therefore it reduced
wall shear stress, (2) tnnt2a MO injection inhibited ventricular contractile function to reduce wall shear stress, and (3) wea mutants lacked
atrial contraction, which then decreased the hemodynamic force applied to the ventricle. By reducing the shear stress on the cardiac walls,
we quantified the Notch signaling via qRT-PCR and found that with reduced WSS, there was reduced Notch signaling. To further prove our
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hypothesis, clo mutants that lacked endocardium did not form trabeculae, and subjecting endothelial cells to pulsatile shear stress with ADAM10
present showed that shear stress activates Notch signaling.

The other imaging techniques such as confocal microscopy can be used to image samples in 3-D™. However, this technique and others have
many drawbacks. For example, the confocal imaging cannot penetrate deeply into samples, has the low axial resolution, and slow scanning
speeds19‘42. Because of the penetration depth limit in confocal imaging, small samples, such as zebrafish embryos, can only be imaged in its
entirety. Two-photon confocal microscopy improves the penetration depth, but the resolution, slow scanning speed, and high cost make this
technique undesirable'®. There have been studies that combine two-photon microscopy and LSFM successfully18, however, the drawbacks are
still prominent42.

LSFM, on the other hand, has the least photo-bleaching and damage13’18’42, fast acquisition speed, and similar penetration depth13. Additionally,
because of the dual lenses and excitation of a single plane (Figure 1), the background noise is substantially reduced®. However, the samples
need to be embedded into gels to immobilize the sample, which makes it difficult to apply to in vivo models other than zebrafish ™71, Also,
utilization of the fluorescent light limits the depth penetration to a few millimeters. Even though LSFM is a great method for visualization, it

is critical that it is supplemented with quantitative data. Because LSFM is only qualitative, it can be subject to various interpretations. Using
gRT-PCR, we could confirm that the LFSM 4-D images were a correct representation of the events occurring in the live samples. Occasionally
in larger samples, stripes and shadows can form in the images. However, dual-sided illumination or mSPIM can be utilized to reduce these
artifacts*?. Because LSFM is so versatile, its capability of capturing high resolution and overall better-quality imazqes makes the future of LSFM
promising. Mentioned previously, LSFM can be combined with other imaging systems for successful imagingm’4 .

We demonstrated;:reviously that applying a pulsatile shear stress of 23 x 10° N at 1 Hz for 24 h substantially upregulates Notch signaling

in vitro(Figure 4)1 . We further demonstrated that shear forces activate Notch signaling by genetic manipulation of hematopoiesis (gatata

MO)4, cardiac contraction (tnntfa MO)5, atrial contraction (wea mutant), endocardial deletion (c/lo mutant), and localization of Notch signaling
(Tglflkz-mCherry;tp1:gfp]). We describe here that by lowering the wall shear stress in the ventricle, that Notch-related genes were down-regulated
(Figure 2K, L, M). Furthermore, we were able to demonstrate that Nrg7 mRNA was able to rescue trabeculation, restore Notch signaling, and
improve ventricular fractional shortening and ejection fraction (Figure 2E, F, H, K-M, Figure 5). The restoration of cardiac function was shown by
the increase in contractile function-mediated hemodynamic forces that activated Notch signaling (Figure 2K-M).

We also determined that the shear stress-activated Notch signaling is endocardial dependent. By using gata’a MO, tnnt2a MO, wea mutant or
AG1478 treatment, trabeculation was inhibited and Notch signaling was down-regulated (Figure 2K-M). However, Nrg1 rescued trabeculation
and Notch signaling in wea mutants and when co-injected with gatata MO (Figure 2D, H, K, L). When wall shear stress (EPO injection) or Notch
signaling (10 pg/nL Nrg1 injection) was increased, there was no change in the EPO group in terms of morphology, but abnormal ventricular
morphogenesis was present in the Nrg17 increased dose (Figure 3).

In conclusion, we have shown that the mechanotransduction of shear stress activates the Notch signaling pathway. By applying 4-D LSFM and
genetically engineered zebrafish, we developed a new model system that shows how critical blood flow is during cardiac development to its
morphology, contractility, and overall function.
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